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KEY LIBRARY SERVICES FOR GRADUATE STUDENTS 

• Interlibrary Loan and Document Delivery 
• Study Carrels 
• Bibliographic Management Software – ProQuest Flow, RefWorks, EndNote Basic 
• Research consultations 

	
  
	
  
RESEARCH STRATEGIES 
Plan 
Before you begin entering terms in a database, I recommend you follow the first five steps below: 

1. Understand your research question. 
2. Identify the major concepts in your question. 
3. Identify potential terms to correspond to those concepts.* 
4. Select alternative terms (narrower, broader, or related) to use if original strategy needs help. 

a. In ERIC use the Thesaurus of ERIC Descriptors; in PsycINFO use Thesaurus of Psychological Index Terms. 
5. Determine logical (Boolean) relationships between terms.** 
6. Begin the search. 
7. Look at a few documents. 
8. Revise & refine search based on initial results.*** 

 
From: Walker, G., & Janes, J. (1999). Online retrieval: A dialogue of theory and practice (2nd ed.). Englewood, CO: Libraries Unlimited. 

 
*Identify the potential terms that represent the concepts of your research question. 

minority	
  populations	
   urban	
   chronic	
  disease	
  

Asian American, Black, African American, 
Hispanic, Latino, Native Hawaiian, Other 
Pacific Islander, American Indian, Alaska 
Native 

(CDC racial & ethnic minority populations) 

inner-city, 
metropolitan area, 
city 

heart disease, stroke, cancer, diabetes, 
obesity, arthritis 

 
**Determine logical (Boolean) relationships between terms. Boolean operators include: and, or and not. 
Initial Search: minority AND urban AND chronic disease 
 
***Revise and refine search based on initial results. 
Revised Search: (minority OR Asian American OR Black OR African American OR Hispanic OR Latino OR 
Native Hawaiian OR Pacific Islander OR American Indian OR Alaska Native) AND (urban OR inner-city OR 
metropolitan area OR city) AND (chronic disease OR heart disease OR stroke OR cancer OR diabetes OR obesity 
OR arthritis) 
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Too many sources Not enough sources Sources not available at 
the Mansfield Library 

  ---Ask your professor or 
librarian for assistance in 
locating locally available 
materials 
 
---Request items via 
Interlibrary Loan 

	
  
Search for Cited References 
If you want to know who has cited a specific article search Web of Science or Google Scholar. PubMed and other 
databases are beginning to provide some of this data, too. 
 

 
Trippany, R. L., White Kress, V. E., & Wilcoxon, S. (2004). Preventing vicarious trauma: What 
counselors should know when working with trauma survivors. Journal of Counseling & Development, 82(1), 
31-37. 
 
• How many times has the article been cited according to Web of Science? 

• How many times has it been cited according to Google Scholar? 

	
  
Locate a Specific Article or Journal 
If you are looking for a specific article (e.g., from a reference list) or a specific journal, the first step is to find out if 
the library subscribes to that journal, either online via a database or in print. Enter the name of the journal in the 
main search box on the library homepage, then choose Journal Titles from the Search In pull-down menu. This will 
show you if the library provides access to the journal in a database, in Mansfield Library Catalog (paper copies), and 
or indicate that the library does not subscribe to the journal. If the library subscribes to the journal, be sure to check 
the dates of coverage that are available. If the library does not have a subscription to the journal you can request 
specific articles from the journal via Interlibrary Loan. If the library only owns the journal in paper you can request 
that articles within it be scanned and emailed to you, too. 
 

 
Villalba, J. A. (2007). Culture-specific assets to consider when counseling Latina/o children and 
adolescents. Journal of Multicultural Counseling and Development, 35(1), 15-25.  
 
• Can you access the article online via the library’s subscription databases? 

• Can you access it in print in the library? 
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RESEARCH RESOURCES 
Indexes 
Anthropological Index Online. Currently indexes 782 journals of which 82 cover a mix of topics that range from 
socio-cultural anthropology to physical anthropology, linguistics and archaeology; 433 are in English. 1957-present. 
 
ERIC (Education Resources Information Center). Over 1.4 million records covering all areas of education such as 
adult, counseling, elementary and early childhood education, second-language learning, special education, and 
teacher education. Indexes journal articles, conferences, meetings, government documents, theses, dissertations, 
reports, audiovisual media, bibliographies, directories, books and monographs. 1966-present. 
 
PsycINFO. Over 3.3 million records covering all areas of psychology, behavioral sciences, and related disciplines 
such as developmental psychology, educational psychology; psychological and physical disorders, social psychology, 
and treatment and prevention. Indexes professional journals, chapters, books, reports, theses and dissertations. 
Some Times Cited data. 1890-present. 
 
Social Services Abstracts. Over 160,450 records covering social work, human services, and related areas, including 
social welfare, social policy, and community development. Indexes over 1,300 journals as well as dissertations and 
book reviews. 1979-present. 
 
Sociological Abstracts. Over 980,500 records covering international literature in sociology and related disciplines in 
social and behavioral sciences such as economic development, family and social welfare, and social development. 
Indexes journals, books, book chapters, book reviews, dissertations, and conference papers. 1952-present. 
 
Worldwide Political Science Abstracts. Over 766,900 records covering international literature in political science 
and its complementary fields, including international relations, law, and public administration and policy. Currently 
indexes over 1,700 journals, 67% of which are published outside the U.S. 1975-present. 
 
Indexes: Region-Focused 
Bibliography of Asian Studies (BAS). Over 805,000 records covering humanities, social sciences, and natural 
sciences pertaining to East, Southeast, and South Asia. Indexes journals, conference proceedings, edited volumes, 
and anthologies published worldwide. 1971-present. 
 
Hispanic American Periodicals Index (HAPI). Indexes contents of scholarly journals published around the world 
on Latin America and the Caribbean. 1970s-present. 
 
Index Islamicus. Over 440,300 records covering literature on Islam, the Middle East and the Muslim world. 
Monitors and indexes over 3,000 journals as well as conference proceedings, monographs, multi-authored works 
and book reviews. 1906-present. 
 
Middle Eastern & Central Asian Studies. Over 639,000 records covering political affairs and law, international 
relations, economic affairs - business and industry, cultural heritage, society and social welfare, ethnic diversity and 
anthropology, significant religious events and movements and more – on the countries and peoples of the Middle 
East, Central Asia and North Africa. 1900-present. 
 
Full Text 
Access WorldNews: Research Collection. News coverage at the international, national, regional, and local level. 
Able to limit your search by continent, region, state, or source. Coverage dates vary by title. 
AnthroSource. Archive of the American Anthropological Association journal publications. 
 
CINAHL Plus with Full Text. More than 770 journals in nursing and allied health, as well as conference proceedings, 
dissertations, and more. Most coverage is from 1981-present. 
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Contemporary Women’s Issues. Coverage of issues and events that influence women’s lives in over 190 countries, 
from mainstream periodicals, the alternative press, newsletters, NGO reports, and gray literature. Coverage dates 
vary by title. 
 
Counseling and Therapy (in Video). Includes 707 videos for the study of counseling, social work, psychotherapy, 
psychology, and psychiatric counseling.  
 
eHRAF World Cultures. Ethnographic collections covering all aspects of cultural and social life. 
 
Ethnic NewsWatch. Regional and national magazines, and journals published by ethnic and minority presses. 1959-
present. 
 
Ethnographic Video Online. Covers every region of the world and features the work of many of the most 
influential documentary filmmakers of the 20th century. Includes interviews, previously unreleased raw footage, 
field notes, study guides, and more. 
 
Professional Development Collection. Nearly 520 high quality education journals, including more than 350 peer-
reviewed titles, designed for professional educators. Coverage dates vary by title. 
 
PsycArticles. Over 70 journals published by APA, the APA Educational Publishing Foundation, the Canadian 
Psychological Association, and Hogrefe & Huber. Most journals are covered from the initial volume and issue of 
publication of the journal-present. 
 
Psychology and Behavioral Sciences Collection. Nearly 400 journals covering topics in emotional and behavioral 
characteristics, psychiatry & psychology, mental processes, anthropology, and observational & experimental 
methods. Coverage dates vary by title. 
 
Social Sciences Full Text. Over 330 journals covering both applied and theoretical aspects of the social sciences 
including Family Studies, Gender Studies, International Relations, Minority Studies, Political Science, Public 
Welfare, and more. Indexing for roughly 750 serials, 670 of which are peer-reviewed. 1972-present. 
 
Open Access Literature 
Open-access (OA) literature is digital, online, free of charge, and free of most copyright and licensing restrictions. 
OA is a kind of access, not a kind of business model, license, or content. OA is compatible with copyright, peer 
review, revenue (even profit), print, preservation, prestige, quality, career-advancement, indexing, and other features 
and supportive services associated with conventional scholarly literature. The primary difference is that the bills are 
not paid by readers and hence do not function as access barriers. The legal basis of OA is the consent of the 
copyright holder (for newer literature) or the expiration of copyright (for older literature). Because OA uses 
copyright-holder consent or the expiration of copyright, it does not require the reform, abolition, or infringement of 
copyright law. The campaign for OA focuses on literature that authors give to the world without expectation of 
payment. Many OA initiatives focus on publicly-funded research. OA is compatible with peer review, and all the 
major OA initiatives for scientific and scholarly literature insist on its importance. The chief difference between 
them is that OA journals conduct peer review and OA repositories do not. This difference explains many of the 
other differences between them, especially the costs of launching and operating them. 

From: Open Access Overview, Peter Suber 
 
Search DOAJ (Directory of Open Access Journals) a directory of open access scientific and scholarly journals that 
publish scholarly or review articles; exercise peer-review or editorial quality control; and are from academic, 
government, commercial, or non-profit private sources. 
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KEEP CURRENT 
Current Awareness Services, such as Table of Contents Alerts, Saved Search Alerts, and Cited Reference Alerts, 
help you keep on top of what is being published in your area of interest, or by specific authors, by automating key 
research practices. These services are provided free by most publishers and database vendors and merely require 
you to register with the publisher or vendor. Depending on the alerting service, you can select to be updated daily, 
weekly or monthly via email or a RSS feed. Once registered, you will receive automatic updates to keep you current 
and aware of research of interest to you. Find out more at Keeping Current. 
	
  
	
  
MANAGE YOUR RESEARCH 
Streamline the management of your research by using a citation management tool. The library provides 
subscription access to two such web-based tools, EndNote Basic and RefWorks. There is also a new program called 
ProQuest Flow (developed by the same company that developed and provides RefWorks). These tools are most 
helpful if you are working on research involving many citations (more than 20) or ongoing projects like a 
manuscript, thesis, or dissertation. You can use EndNote Basic or RefWorks to: create your own personal database 
to keep track of your research articles, documents, websites, etc.; automatically generate a bibliography in a variety 
of styles (e.g., APA, ASA, Chicago, MLA); add in-text citations to Word documents; and share your research 
sources. 
 
Flow additionally allows you to annotate documents, drag and drop pdf files into the system from which metadata is 
automatically drawn, and import existing libraries (e.g., RefWorks, Mendeley). ProQuest representatives will be 
offering a training session on Flow titled, “Organizing, annotating, and citing your digital references” on Thursday, 
October 23 from 4-5pm in the library’s Student Learning Center (283). 
 

	
   RefWorks	
  

Access	
   Click the “Databases” link on the homepage, the “R” tab, then “RefWorks.” 

Set	
  up	
  an	
  
account	
  

Use your official UM email address. Off-campus access requires a Group Code that will be sent to 
you when you set up your account, and can be re-sent to you if you send an email from your UM 
email to refworks@umontana.edu. 

Add	
  
citations	
  

Click the “References” menu, then “Add New”. You can also add citation data from various 
databases, usually under “Export” or “Save Citations.” In some instances this is seamless (e.g., using 
CSA databases), in other instances you will need to download the data and then use the “Import” 
option under the “References” menu. 

Organize	
  
citations	
  

Select the “New Folder” button to add a new folder. A citation can be placed in more than one 
folder. Select the “Organize & Share Folders” tab to make changes. Folders can be shared with both 
RefWorks and non-RefWorks account holders via email, URL, or in UM’s RefWorks RefShare area. 

Find	
  
citations	
  

Use the “Search” box. Citations can also be viewed by author, journal/periodical, or 
subject/descriptor by selecting “Search” menu. 

Create	
  
in-­‐text	
  
citations	
  

Requires you to download a utility program to your computer called “Write-N-Cite” that works 
with most MS Word programs. Find the utility under the “Tools” menu. If you want to use 
ProQuest’s Flow you should download the “ProQuest for Word” plugin that works with both 
RefWorks and Flow. 

Bibliography	
   Use the “Bibliography” menu or “Create Bibliography” button. 

Get	
  help	
   RefWorks tutorials. A “Help” menu is available in RefWorks. 

	
  


